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Introduction

Elixir PageHandler is used in conjunction with Elixir
PrintDriver for Xerox to generate two-sided, two-up
metacode documents for printing on Xerox
9700-series printers.
Xerox printers supported by Elixir PageHandler are
the Xerox 9790, 9700, 8790, 8700, 4890, 4850, 4650
(300 dpi), 4090 and 4050 printers. As these printers
are all compatible, throughout this manual they are referred to collectively as Xerox 9700 printers.
This user guide describes only the options provided
with Elixir PageHandler. For options provided with
Elixir PrintDriver for Xerox, see your Elixir PrintDriver
for Xerox User Guide.

PageHandler overview
Elixir PageHandler provides additional options for use
with Elixir PrintDriver for Xerox. These options allow
you to generate two-sided, two-up metacode documents for printing on Xerox 9700-series printers. You
can use these printing options to create high quality
booklets such as this manual.
Elixir PageHandler also allows multiple impositions on
a page and full control over the way in which duplex
pages are printed.
PageHandler options
Elixir PageHandler allows you to choose from the following printing options:
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One-up portrait printing with rotate duplex printing
Two-up portrait printing with rotate duplex printing
One-up landscape printing with rotate duplex
printing
Two-up landscape printing with rotate duplex
printing
One-up portrait printing with tumble duplex
printing
Two-up portrait printing with tumble duplex
printing
One-up landscape printing with tumble duplex
printing
Two-up landscape printing with tumble duplex
printing.
Font considerations
Elixir PageHandler supports fonts generated by Elixir
PrintDriver, including ATM or TrueType. To print
booklet-type documents, you must also have inverse
fonts. For information about generating these inverse
fonts, see the "Elixir PageHandler options" chapter.
Xerox control files
The same JSL and JDL used for printing Windows applications through Elixir PrintDriver may be used for
printing files produced by using Elixir PageHandler
options.
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Release notes
Release notes appear at the beginning of the Elixir
software install process, so that you can review each
entry before performing the complete installation.
Once the software is installed, release notes can be
accessed from the Help menu of the application. Release notes are formatted for viewing in Notepad or
Wordpad. They have a txt file extension and are
found in the drive:\ELIXIR \RELNOTES directory.

Customer support
Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.
If you have any problems running or using Elixir applications, call your customer support center telephone
number in your area for help. When calling, you will
be asked for the following information:
your name, organization, telephone number, and
address
the name and version number of the Elixir
application
a complete description of the problem, including
any error messages displayed on your monitor or
printed on your printer.
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Xerox customer support center
If you have purchased your Elixir product directly from
Xerox Corporation then you should contact the Xerox
customer support center telephone number provided
by Xerox.
For future reference, please record your Xerox customer support number below.

Xerox customer support center telephone
Elixir customer support centers
If you have purchased your Elixir product directly from
Elixir Technologies then contact the support center for
your region.
North and South America
+1 805 641 5900 ext. 3
Asia Pacific
+92 (0) 51 206182
Europe
+420 2 2431 13877
The U.S.A. Elixir Customer Support Center provides
telephone technical assistance for Elixir users Monday
through Friday from 6:30 a.m. to 5:00 p.m. Pacific
Standard Time.
You can contact Elixir support by accessing the Elixir
World Wide Web page (and selecting [Contact Support]) at http://www.elixir.com. Please complete the
question form.
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Elixir Web site support
The Elixir Web site at http://www.elixir.com offers the
following resources:
Raise a question for Elixir Support.
Find answers in the list of Frequently Asked
Questions.
Review the latest Tips and Techniques for increasing productivity using Elixir software.
Download new releases and the latest patches.
View Release Notes for the latest available
features.
Learn in the user newsgroup how others are using Elixir products.
Sign up for an Elixir Learning Program.

Who should use this guide
This guide is intended for users familiar with Windows
and with Xerox printer and font management
operations.
Users should be familiar with PC peripherals and have
access to reference manuals for PC software and
hardware and for the Xerox printer(s) used.

Hardware and software requirements
The following sections describe the hardware and
software requirements for running Elixir PageHandler.
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Hardware
Recommended PC configuration: Pentium (or
100% compatible), with at least 133 MHz processor
(or the fastest commercially available processor); 32
MB RAM, 500+ MB hard drive, one CD-ROM drive.
Additional requirements:
any monitor with driver software supporting Windows in VGA or SVGA.
any Windows compatible mouse.
Optional requirements:
One of the following for communicating with
Xerox printers:
Any PC-to-mainframe or communications
board that supports binary file transfers (such
as IBM PC3270, IRMA FT/3270, or AS/400
PC communications packages).
Any 9-track, 1600 or 6250 bpi tape drive
(such as the Qualstar with the Overland TX-8
controller card).
For users with compatible PCs, the ElixiDisk
utilities described in the "Stand-alone utilities"
chapter also allow transferring files between
your PC and Xerox production printers.
Due to hardware and BIOS differences, PS/2
systems and some IBM-compatible PCs do
not support this function.
A Xerox production printer
Tape drive configuration
If you use a Qualstar tape unit, copy the
TAPE_MT0.SYS file (and, if provided, the
LDIMG.EXE file) from the driver diskette supplied by
Qualstar to your root directory.
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Add the following line to your CONFIG.SYS file:
DEVICE= TAPE_MT0.SYS 8
If LDIMG.EXE is included on the Qualstar driver
diskette, add the following command to your
AUTOEXEC.BAT file:
LDIMG
To access Elixir stand-alone utilities from any
DOS subdirectory, make sure you add \ELIXIR or
your ElixiSys custom directory selected at installation, to the PATH= statement in your
AUTOEXEC.BAT file.
For example, if your AUTOEXEC.BAT file contains the following line:
PATH=C:\;C:\DOS;D:\UTILS
Modify the PATH= statement as follows:
PATH=C:\;C:\DOS;D:\UTILS;drive:\ELIXIR
drive:
is the hard disk drive on which you install Elixir
PageHandler (see the "Elixir PageHandler Installation" section in this chapter).
Use any text editor in non-document mode (to generate ASCII text) to add text to the CONFIG.SYS and
AUTOEXEC.BAT files.
Make sure you reboot your PC so that any changes in
your CONFIG.SYS and AUTOEXEC.BAT files take
effect.

ELIXIR PAGEHANDLER USER GUIDE
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Software
Software requirements: Microsoft Windows 95, Wincows 98 or Windows NT 4.0 or later.
While we make every effort to ensure the proper operation of our software, some problems cannot be resolved due to differences in the operating systems.
At this time, we do not support OS/2.

Conventions
This section describes the following:
display conventions
typographical conventions
mouse operations.
Display conventions
Elixir PageHandler adheres to Microsoft Windows
conventions for using menus, menu commands, dialog boxes, command buttons, icons, and a mouse.
See your Windows manual for more information.
Typographical conventions
The following typographic conventions are used
throughout this guide.
Keystrokes are shown enclosed in <
brackets). For example, <Enter>.

> (angle

Key combinations are denoted by a plus sign between keys. For example, <Shift> + <F1> indicates to simultaneously press the <Shift> and the
<F1> keys.
Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example,
Pull down the File menu and select [Print].
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Command buttons that you press are also enclosed in [ ] (square brackets). For example,
Click on [Job Print Ticket].
Commands, options, actions, and parameters
that require description are shown in bold followed on the next line by the description. For example:
drive
Specify the output drive for the resources.
Steps in a procedure are shown in numbered bold
paragraphs. For example:
1.

Click on [Job Print Ticket] in the Main Setup
dialog box.
Comments relating to a step (such as this paragraph) are shown in regular text following the bold
paragraph.
Commands you enter at the DOS prompt are
shown in larger text. Within DOS commands,
variable names and keys you press are shown in
italics. For example:

CD \ELIXIR <Enter>
Mouse operations
You can perform most operations in Elixir applications
by using the mouse. The terminology is similar to
other Windows-based applications.
Mouse operations are performed using the left mouse
button.
The following mouse-related terms are used in this
guide:
click
to momentarily press and release the left mouse button once.
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double-click
to click the left mouse button twice in rapid
succession.
object
a selectable item on the screen.
open
to point and double-click on an object -- the effect of
this operation depends on the object.
point
to move the mouse to position the screen pointer on
an area of the screen.
select
to point to an object and click the mouse -- this usually
highlights the object.

On-line Help
Elixir software uses the Microsoft Windows Help program to provide on-line Help for Elixir PageHandler
functions.
For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.
The Help files included with your Elixir software include graphics which were created using screen drivers with large fonts. If you use a screen driver with
small fonts, the Help file graphics may not display
clearly. For optimum graphics display, use a screen
driver that uses large fonts.
Using on-line Help
You can access on-line Help by clicking on the [Help]
button in a dialog box to view an associated Help
topic. For Elixir PageHandler Help files, click on the
[Mip Help] button in the Metacode Converter Options
dialog box or in the PrePrint dialog box.
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Note: In Windows 95 you can click the right
mouse button on an option in a dialog box to display Help about that option.
Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.
Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots." Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions).
Move the cursor over a hypergraphic until a hand displays, then click on this hot spot to display a pop-up
topic, or a "jump." To close a pop-up topic, click the
mouse button. To return to the original Help topic
from a jump, click on <Back> in the Help file menu.
Searching for a different topic
If you want to jump to a Help topic that is not displayed on your screen, click on the [Contents] button
at the top of the Help screen to display a list of available topics and make your selection. You can also
click on the [Search] button at the top of the screen
and select a related topic.

Organization of this guide
This user guide contains the following chapters:
Chapter 1, "Introduction," provides an introduction to
Elixir PageHandler, describes the contents of this user
guide, and explains the installation process.
Chapter 2, "Elixir PageHandler options," describes
how to set Elixir PageHandler options for printing twosided, two-up.
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Chapter 3, "Sample output formats," provides examples of different output print formats.

Before installing
Elixir PrintDriver must be installed before you install Elixir PageHandler. Note the drive where
you have Elixir PrintDriver installed. This is the
drive where you must install Elixir PageHandler.
Complete the software licensing process (See the
"Product Registration" section).
You may want to make backup copies of your
diskettes prior to installation.
To avoid any possible conflicts, exit all other applications while installing Elixir PageHandler.

Product Registration
Elixir products no longer require ElixiKey hardware devices attached to your parallel port. Elixir products
now utilize soft key technology. This new licensing
process validates your license agreement with Elixir
and places a file (password.epw if an Elixir customer,
or License.dat if a Xerox customer) on your
workstation.
Version 4.00 implements Elixir's new licensing process and discontinues use of the current hard keys. All
customers must register/re-register software license(s) by using the Elixir registration program provided
with the software.
Each product installed is assigned to a specific pc.
This pc number, your customer number, and password are required. This information is provided when
you purchase Elixir software or when you upgrade to
version 4.00 of Elixir products.
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If you are an Elixir customer, registration can be completed automatically if you have an internet connection
on your workstation. If you are a Xerox customer you
must contact Xerox to register your products.
This section describes the registration process for
those customers who have purchased their Elixir
products form Elixir Technologies.
The following scenarios describe the registration
process for Elixir customers. Xerox Corporation will
provide a separate document that describes registering your products with Xerox.
you are a new customer and will use Soft Key
registration
you are an existing customer and will change to
Soft Key registration
Elixir Product Registration screen
Make your selections according to your needs and go
to the appropriate section for further procedures.

Figure 2-1. Elixir Product Registration screen
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Using the internet
You can register and download all registration files via
the Elixir Product Registration program. There are
two ways to register your products using the Internet:
down load the product registration file directly to
the Elixir PC via the Internet (see "Registering as
a new customer via the internet")
download the product registration file to another
machine and move it to the Elixir PC (see "Downloading via the internet to a non-Elixir PC")
Registering as a new customer via the internet
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.

2.
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Letter), then click on [Next].
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3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[Yes].
The system displays your customer information
and you must verify that it is correct.

6.

When the screen displays the registration
information, click on [Save]. You may also
print this screen for reference or to send to
Elixir.

The application installation process will begin, see the
"Installation" section.
Downloading via the internet to a non-Elixir PC
You will receive a "Customer Activation Letter" with
your product(s) ordered. The registration process
should be completed before installing your software.
The installation CD will launch and install the Registration Program.
To install the registration program on your Elixir PC:
1.

In the Software Registration screen, click on
[Next].

2.

Select the drive and click on [Next].

3.

In the Start Registration Process screen, click
on [Install].
The password file will be installed and your system configured.

ELIXIR PAGEHANDLER USER GUIDE
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To complete registration:
1.

In the Elixir Product Registration "Welcome"
screen, select [Next].
Your machine serial number displays.

2.

Enter your customer number (from Activation
Letter), then click on [Next].

3.

Enter your password and the PC number you
want to register, then click on [Next].

4.

Select [Prepare and download my initial
product license registration. This workstation
or another pc is connected to the internet]
from the Registration Option menu, then click
on [Next].

5.

In the Download Password screen, click on
[No].

6.

In the How to Contact Elixir screen, click on
[Print] and take the printout to the pc
connected to the internet.

7.

Access
the
Elixir
Web
site
at
http:\\www.elixir.com. and click on [Product
Registration].

8.

In the Customer Information screen, enter
your Customer Number and Password, then
click on [Submit Form].

9.

In the Elixir Customer Menu,
[Download a New License File].

click

on

10. In the Customer Information screen, enter
your PC Number and Machine Serial Number,
then click on [Submit Form].
11. In the Elixir Technologies screen, click on
[Click here to download your password].
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12. Save the password.epw file to diskette and
copy it to your Elixir PC in the \ELIXIR
directory.
The application installation process will begin, see the
"Installation" section.
Contacting Elixir (no internet connection)
If you have no internet access at your site you must
contact Elixir and provide the serial number of the pc
where you will install the Elixir software. Elixir will provide a registration file (password.epw) that you must
copy to the Elixir pc.
Copy the password.epw file to \Elixir and start the
installation.
Select [Prepare my initial product license registration.
This workstation is not connected to the Internet] from
the Registration Option menu, then click on [Next].
The application installation process will begin, see the
"Installation" section.
Soft key customers running Windows for Workgroups 3.1 or 3.11
Since Windows 3.1/3.11 does not have internet capability, you must contact Elixir to obtain your password
file. After installation of Elixir software, the installation
program verifies that the operating system is 3.1 or
3.11, runs passwd16.exe, and provides your machine
serial number.
To complete registration:
1.

Enter your customer number, password and
PC number, then print out a copy of this
screen.

2.

Fax, email, or mail Elixir the display printout.
Elixir will generate a password.epw file and
send it to you on diskette.

3.

Load the password.epw file in the \ELIXIR
directory.
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The application installation process will begin, see the
"Installation" section.

Installation
This section describes how to install Elixir software
using the [Full] and [Custom] options. Installing additional Elixir applications to an existing version is also
explained.
Note: The software registration process must be completed (See the "Product Registration" section).
For information about starting Elixir applications after
installation, refer to the "Introduction" chapter.
During installation, the log file, XWIN.log, is created in
the drive:\Elixir directory. XWIN.log contains a list of
all directories and files copied or created, including information pertinent to the installation. It can be accessed, using Notepad or Wordpad.
If you have any problems running Elixir software after
installation, refer to the "Troubleshooting" section of
the Elixir Getting Started Guide for more information.
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Installing Elixir applications
Elixir provides a simple, interactive procedure for installing Elixir applications.
During installation you can select [Full] or [Custom]
installation.
Selecting a [Full] installs all Elixir applications and
demonstration files on the same drive. If you
have a previous version of Elixir software, this option overwrites the existing version.
Selecting a [Custom] installation allows you to
choose the Elixir applications and options (such
as Elixir demonstration files) you want installed,
as well as where you want certain options installed. For example, You may want the PDF
documentation in a different directory than the application.
You can also install Elixir program files (required
to run Elixir), and data files (files that you create
or files such as the Elixir demonstration files), in
separate drives and directories.
Full installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
1.

Close all active applications.

2.

Insert the CD in your CD-ROM drive.

3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.
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5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select [Full]
and click on [Next].

9.

Select the drive on which you want Elixir
software installed, then click on [Next].

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].
12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Custom installation
To begin installation:
You can quit installation at any time, by pressing the
<Esc> key.
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Close all active applications.

2.

Insert the CD in your CD-ROM drive.
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3.

In the "Welcome" screen, click on [Next].
The Release Notes? screen displays.

4.

Select [Read Release Notes Now] to display
them in Wordpad (or Notepad), or click on
[Next] to proceed with the installation.
The Product Selection screen displays.

5.

Select the applications you want to install and
click on [Next].
The Selected Products screen displays.

6.

Verify the listed applications and click on
[Next]. If you need to delete or add to the list,
click on [Back] and reselect.

7.

Verify your user information and click on
[Next].

8.

In the Select Install Type screen, select
[Custom] and click on [Next].

9.

In the Configuration Only? screen:
Selecting [Yes] allows you to load Configuration, Program, and Data files into any resident directory.
Selecting [No] allows you to deselect options
you do not wish installed.

10. Select the Programs Folder in which you want
Elixir software installed (Elixir Applications is
the default), then click on [Next].
11. In the Backup Replaced Files screen, click on
[Yes], if you want to make back-up copies of
all files replaced during installation and select
the directory where the back-up files will be
placed. Then click on [Next].

ELIXIR PAGEHANDLER USER GUIDE
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12. In the Start Copying Files screen, click on
[Install].
Installation begins.
13. Once installation is complete, click on [Exit
Installer].
Adding applications
If you did not install all of the Elixir options while performing the Custom installation procedure, you can do
so at any time by following the steps described in the
"Custom installation" section of this chapter.
Adding newly licensed applications
If you purchase additional Elixir products, Elixir will
update your password file. You can access the Product Registration program from your program group
and re-download your initial product registration password file to activate your new products.

Checking installation
To verify that Elixir PageHandler was installed successfully, from the Elixir PrintDriver Main Setup dialog
box, select [META Options] and check that the Elixir
PageHandler page options display in the Metacode
Converter Options dialog box or select [PrePrint Options] and check that the [MIP Meta] option displays in
the PrePrint dialog box.

Starting Elixir applications
Using Windows 95, Windows 98, or Windows NT:
Start PageHandler by clicking on the [Start] button and
choosing Programs> Elixir Applications> Elixir
PageHandler.
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Elixir PageHandler
options

This chapter describes how to set Elixir PageHandler
options for printing two-sided, two-up metacode documents. For information about setting all other options
and defaults in Elixir PrintDriver, see your Elixir PrintDriver for Xerox User Guide.

Accessing Elixir PageHandler options
Elixir PageHandler options display in Elixir PrintDriver's Metacode Converter Options dialog box and
in the PrePrint dialog box. You can access these dialog boxes from the Elixir PrintDriver Main Setup dialog
box.
To access the Main Setup dialog box:
1.

Open the Control Panel in the Windows
Program Manager and double-click on the
Printers icon.
The Printers dialog box displays.

Figure 2-1. Printers dialog box
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2.

Select [Elixir PrintDriver on DISK].

3.

Click on [Setup].
The Main Setup dialog box displays.

Figure 2-2. Main Setup dialog box
You can also access the Main Setup dialog box from
within some applications. See your application manual for details.
Metacode Converter Options dialog box options
To access the Metacode Converter Options dialog
box, click on [META Options]. The Metacode Converter Options dialog box displays.
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Figure 2-3. Metacode Converter Options dialog box
Select the following options:
DJDE Prefix:
Specify the Dynamic Job Descriptor Entry (DJDE) prefix up to 50 characters. The default is $DJDE$.
Offset:
Specify the number of characters or spaces present
before the first character of the DJDE string.
Skip:
Specify the total number of characters or spaces to
skip before reading a command.
JDE string
Specify the Job Descriptor Entry you want to use from
the Elixir JSL. You can use up to 6 characters. The
default JDE is DFAULT.
Output to
Select [Disk] (the default) to output to disk or select
[Tape] to output to an attached tape unit.
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Metacode Types
Select the metacode type:
Select [Offline] (the default) for tape or [Online] for host connected.
Select [Color] for color or [BW] for black and
white.
If you select [Color] and your printer does not support
it, your file will print in black and white.
Note that when you change the color option in this dialog box, the color option in the Color Services dialog
box also changes so that both options are the same.
Presentation
Select how the page prints:
Select [Duplex] to print on both sides of the
paper.
Select [Simplex] (the default) to print on one
side of the paper.
Copies
Specify the number of copies you want to generate.
Image Compression
Select this option to compress duplicate lines, blank
lines and white space.
If you do not compress your print file and decide you
want to compress it at a later time, you can use the
METACOMP utility to compress the file. See the
"Stand-alone utilities" chapter in your Elixir PrintDriver
for Xerox User Guide for more information.
Optimize
Select this option to reduce the size of the file and the
text placement statements at the printer. Note that if
you use this option, you can convert the file to Elixir
format using the ElixiSys Desktop or ElixiSys Desktop
for Highlight color but you cannot edit the converted
text.
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Page Imposition
Select the page imposition:
Select [1-UP] to keep the original page layout
in effect.
Select [2-UP] (the default) to print two originals on one metacode page.
Page Direction
Select the page direction:
Select [Rotate] (the default) to print the reverse side of the duplex page from top to
bottom.
Select [Tumble] to print the reverse side of
the duplex page from bottom to top.
Page Layout
This option is available if [2-UP] imposition is selected.
Select [All left] to print a left-page only Windows application source document with correctly formatted left and right pages in two-up
format.
Select [Right left] (the default) to print a right
and left page Windows application source file
in two-up format.
These choices are valid only if Collate is set to [Yes].
Shift in Short Direction:
Select this option to adjust for incorrect reverse portrait page positioning on A4 paper or to adjust printing
for 3-hole punched.
A positive value shifts print output right and
up the reverse side of the page by the number of dots you specify.
A negative value shifts the print output left
and down the reverse side of the page by the
number of dots you specify.
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Shift in Long Direction:
Select this option to adjust for incorrect reverse landscape page positioning on A4 paper or to adjust printing for 3-hole punched.
A positive value shifts print output right and
up the reverse side of the page by the number of dots you specify.
A negative value shifts the print output left
and down the reverse side of the page by the
number of dots you specify.
Collate:
This option is available if [2-UP] page imposition is
selected.
Select [Yes] (the default) to have the first and
last pages printed two-up on the first sheet of
paper, the last and next-to-last pages printed
two-up on the second sheet (or the back of
the first sheet), and so on.
Select [No] to have each document page
printed twice, two-up on a sheet.
Select [Sorted] to have four-page blocks
printed with pages 1 and 3 two-up on the first
sheet, and pages 2 and 4 two-up on the reverse side of the sheet (see the examples at
the end of this document).
When you select [No] or [Sorted], the [Page Layout]
option must be set to [Right left].
A complete document is produced by cutting the output stacks between two-up pages, creating two
stacks. Recombining the stacks by selecting alternate
sheets from each stack, produces the final collated
copy.
Create Inverse Fonts:
Specify if you want to create inverse fonts:
Select [Yes] (the default) to have the fonts
necessary for both [Rotate] and [Tumble]
page directions converted and saved to your
hard drive.
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Select [No] to skip this process.
The first time you run Elixir PageHandler, you must
select [Yes]. Since the converted fonts are saved to
your hard drive, select [No] for subsequent conversions if the same document is being printed.
PrePrint Options dialog box
To access the PrePrint dialog box, click on [PrePrint
Options]. The PrePrint dialog box displays:

Figure 2-4. PrePrint dialog box
The PrePrint dialog box also displays when you select
[Print] from your application with the Elixir PrintDriver
set as the printer for the document, allowing you to
check or to change the output configuration.
To change a selection, insert the cursor in the box and
type a new path or job ID. Any changes will be reflected in the original setup dialog box for that option.
Job ID
Specify the output file name up to 6 characters. The
default is the Job ID entered in the Job Print Ticket
dialog box. See the Elixir PrintDriver for Xerox User
Guide for detailed information about the Job Print
Ticket dialog box.
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Document Name
Specify up to 6 characters for the metacode file name.
If you selected the [8 char. page name] in the Job
Print Ticket dialog box, you can specify up to 8 characters. (See the Elixir PrintDriver for Xerox User
Guide for information about the [8 char. page name]
option.) The default document name is the same as
the Job ID name.
Output Format
Only metacode output is valid for Elixir PageHandler
printing. To output documents to other formats, see
your Elixir PrintDriver for Xerox User Guide.
MIP META
to generate metacode files formatted as specified
by [2-UP] under [Page Imposition] in the Metacode Converter Options dialog box.
The default directory for
drive:\ELIXIR\DOCS\MIPOUT.

MIP

metacode

is

Regenerate fonts
When you select [Regenerate fonts], the Font Generation Prompt dialog box displays the settings for
fonts previously generated in your document. This allows you to change previously selected settings. For
example, you may already have 9700 fonts and now
want to make 5word fonts also.
Note that you do not need to regenerate fonts that
were previously generated.
The default setting is deselected.
Show conversion status
When this option is selected, the status of the conversion displays. If you are converting a PageMaker file,
make sure this option is deselected.
Highlight color output
Select this option to use highlight color in your document, for printing on a 4850 or 4890 printer or deselect this option to print in black and white on any of the
supported Xerox printers. You can specify the default
color option in the Color Services dialog box. For
more information about this dialog box, see the Elixir
PrintDriver for Xerox User Guide.
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Note that if you select [Highlight color output] and your
printer does not support color, your file will print in
black and white.
Print chapters
If your file contains multiple files or chapters, select
this option and specify the number of chapters in the
window. For example, to print a Master Document or
PUB file containing nine chapters, select the option
and specify 9 in the window.
For subsequent print jobs, make sure you reset this
option to specify the correct number of chapters.
Click on [OK] to accept the PrePrint dialog box configuration.
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3.

Sample output formats

The following chapter provides examples of different
output print formats illustrating Elixir PageHandler's
capabilities.
Examples in this chapter include the following output
print formats:
2-UP, rotate and sort output
2-UP, rotate, and non-collated output
2-UP, rotate, and collated output
2-UP, tumble, and collated output
2-UP, tumble, and non-collated output
2-UP, tumble, and sorted output
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2-UP, rotate and sort output
Figure 3-1 shows the first sheet of a print operation
when the Metacode Converter Options dialog box is
set as follows:

Imposition: 2-UP
Collate: Sorted

Direction: Rotate
Page Layout: All Left

Figure 3-1. 2-UP, rotate and sort output
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2-UP, rotate, and non-collated output
Figure 3-2 shows the first sheet of a print operation
when Metacode Converter Options dialog box is set
as follows:

Imposition: 2-UP
Collate: No

Direction: Rotate
Page Layout: All Left

Figure 3-2. 2-UP, rotate, and non-collated output
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2-UP, rotate, and collated output
Figure 3-3 shows the first sheet of a print operation
when the Metacode Converter Options dialog box is
set as follows:

Imposition: 2-UP Direction: Rotate
Collate: Yes
Page Layout: All Left/Right Left
Note: [Page Layout] is set to All Left or Right Left
based on your original page layout specifications.

Figure 3-3. 2-UP, rotate, and collated output
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2-UP, tumble, and collated output
Figure 3-4 shows the first sheet of a print operation
when the Metacode Converter Options dialog box is
set as follows:

Imposition: 2-UP
Collate: Yes

Direction: Tumble
Page Layout: All Left/Right Left

Note: [Page Layout] is set to All Left or Right Left
based on your original page layout specifications.

Figure 3-4. 2-UP, tumble, and collated output
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2-UP, tumble, and non-collated output
Figure 3-5 shows the first sheet of a print operation
when the Metacode Converter Options dialog box is
set as follows:

Imposition: 2-UP
Collate: No

Direction: Tumble
Page Layout: All Left

Figure 3-5. 2-UP, tumble, and non-collated output
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2-UP, tumble, and sorted output
Figure 3-6 shows the first sheet of a print operation
when the Metacode Converter Options dialog box is
set as follows:

Imposition: 2-UP
Collate: Sorted

Direction: Tumble
Page Layout: All Left

Figure 3-6. 2-UP, tumble, and sorted output
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